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Avaya Solution & Interoperability Test Lab

Application Notes for Nuance OpenSpeech Attendant with
Avaya Voice Portal — Issue 1.0

Abstract

These Application Notes describe the configuration steps required to integrate the Nuance
OpenSpeech Attendant with Avaya Voice Portal and Avaya Aura™ Communication Manager.
Nuance OpenSpeech Attendant allows callers to speak the name of a person, department,
service, or location and be automatically transferred to the requested party without waiting to
speak to an operator. In addition, the caller may dial an extension number to transfer to the
requested party.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the configuration steps required to integrate the Nuance
OpenSpeech Attendant with Avaya Voice Portal and Avaya Aura™ Communication Manager.
Nuance OpenSpeech Attendant allows callers to speak the name of a person, department, service,
or location and be automatically transferred to the requested party without waiting to speak to an
operator. In addition, the caller may dial an extension number to transfer to the requested party.

1.1. Interoperability Compliance Testing

The interoperability compliance test included feature and serviceability testing. Feature testing
focused on Nuance OpenSpeech Attendant (OSA) successfully recognizing spoken names and
extensions entered via DTMF and transfer the call to the correct destination. Blind, supervised,
and bridged transfers were verified. Other features covered included barge-in / no barge-in,
adding new transfer entries, recording caller utterances, and accessing Maintenance Mode and
Personal Administration Mode to record name and change PIN.

Serviceability testing focused on verifying the ability of the Nuance OSA to recover from
adverse conditions, such as server restarts, power failures, and disconnecting cables to the IP
network.

Note: Nuance OSA was tested with Avaya Voice Portal using an H.323 and SIP integration.
The Avaya Voice Portal SIP integration used Avaya Aura™ SIP Enablement Services 5.2.1.
These Application Notes cover the configuration of Avaya Voice Portal using the H.323
integration.

1.2. Support

To obtain technical support for Nuance OpenSpeech Attendant, contact Nuance via email or
through their website.

e Web: www.network.nuance.com
e Email: SpeechAttendant.Support@nuance.com
e Phone: (866)434-2564 or (514) 390-3922
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2. Reference Configuration

Figure 1 illustrates the configuration used to verify the Nuance OpenSpeech Attendant (OSA)
solution with Avaya Voice Portal, Avaya Aura™ Communication Manager, and the Nuance
Speech Server. Nuance OSA is deployed on a dedicated application server running Windows
2003 Server. Avaya Voice Portal interfaces to Avaya Aura™ Communication Manager using a
VoIP H.323 interface. Avaya Voice Portal manages the interactions with speech server
resources (i.e., speech recognition and text-to-speech) using VXML applications. VXML pages
generated by Nuance OSA are loaded and interpreted by Avaya Voice Portal, which controls the
interaction with the user. To access the Nuance OSA application, a VoIP channel on Avaya
Voice Portal must be configured to invoke the VXML application when an incoming call is
received on that channel.

Avaya S8730 Servers
(10.32.24.10)
Nuance OSA
(10.32.24.141)

Avaya G650 Media Gateway
(CLAN: 10.32.24.20)

Nuance Speech Server
(10.32.24.140)

Avaya 9600 Series
IP Telephones

(10.32.24.31)

Avaya Voice Portal

Figure 1: Configuration with Avaya Voice Portal and Nuance OpenSpeech Attendant
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2.1. Equipment and Software Validated

The following equipment and software were used for the sample configuration:

Equipment Software

Avaya Voice Portal 5.1(5.1.0.0.4201)

Avaya Aura' Communication Manager 5.2

Avaya S8730 S ith a G650 Medi
vaye ervers with a edia (R015x.02.0.947.3) with Service Pack 3

t
Gateway (Patch 17579)
Avaya 9600 Series IP Telephones 3.0 (H.323)
Nuance OpenSpeech Attendant (OSA) 4.0

Nuance Speech Server

e Nuance License Manager 11.1.0
e Nuance Speech Server 5.1.1
e Nuance Recognizer 9.0.12
e Nuance Vocalizer Network 5.0.0
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3. Configure Avaya Aura™ Communication Manager

This section describes the configuration of H.323 stations and the IP codec set for Voice Portal.
This configuration also requires a C-LAN and Media Processor board for IP communication.
This configuration is outside the scope of these application notes, but the reader may refer to [1]
and [2] for additional information.

Note: Special application SA8874 — Call Status Messages for 7434ND IP Softphone is required
to support supervised transfers from Voice Portal.

From the System Access Terminal (SAT), add an H.323 station for Voice Portal. A call to this
station will terminate to Voice Portal which will invoke the Nuance OSA application. In the
station form, set the Type to 7434ND, set the Port field to /P, provide a descriptive Name, set
the Security Code, and set the IP Softphone field to y.

add station 23802 Page 1 of 6
STATION
Extension: 23802 Lock Messages? n BCC: O
Type: 7434ND Security Code: XXXXX TN: 1
Port: IP Coverage Path 1: COR: 1
Name: VP 192.45.122.50 Coverage Path 2: COS: 1

Hunt-to Station:
STATION OPTIONS
Time of Day Lock Table:

Loss Group: 2 Personalized Ringing Pattern: 1
Data Module? n Message Lamp Ext: 23802
Display Module? vy
Display Language: english Coverage Module? n
Survivable COR: internal Media Complex Ext:
Survivable Trunk Dest? y IP SoftPhone? y

IP Video Softphone? n

Figure 2: Station Form

In the IP codec set form associated with the IP network region of the H.323 station, configured in
Figure 2, set the Audio Codec field to the appropriate value. In this configuration, G.71IMU
was used.

change ip-codec-set 1 Page 1 of 2
IP Codec Set

Codec Set: 1

Audio Silence Frames Packet
Codec Suppression Per Pkt Size (ms)
1: G.711MU n 2 20

23

Figure 3: IP Codec Set Form
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4. Configure Avaya Voice Portal

This section covers the administration of Voice Portal. The following Voice Portal configuration

steps will be covered:

e Configuring an H.323 VoIP connection

¢ Adding an MPP server

e Configuring the VoIP audio format (mu-law or a-law)
e Adding a speech server

e Adding applications

e Starting the MPP server

Voice Portal is configured via the Voice Portal Management System (VPMS) web interface. To
access the web interface, enter http://<ip-addr>/VoicePortal as the URL in an internet browser,

where <ip-addr> is the
screen shown in
Figure 4 is displayed.

IP address of the VPMS. Log in using the Administrator user role. The

AVAYA

Voice Portal 5.1 (VoicePortal)

Expand &ll | Collapse all

* User Management
Raoles
Users
Login Options

* Real-Time Monitoring
System Monitor
Active Calls
Part Distribution

* System Maintenance
Audit Log Viewer
Trace Viewer
Log Viewer
Alarm Manager

* System Management
MPP Manager
Software Upgrade
Systemn Backup

¥ System Configuration
Alarm Codes
Alarm/Log Options
Applications
MPP Servers
Repaort Data
SNMP
Speech Servers
VoIP Connections
VPMS Servers

* Security
Certificates
Licensing

* Reports
Standard
Custom
Scheduled

Welcome, admin
Last logged in today at 1:57:54 PM EDT

Voice Portal Management System version 5.1.0.0.4201

Voice Portal Management System (WPMS) is the consolidated web-based application for administering
Vaoice Portal. Through the WPMS interface, vou can configure Voice Portal, check the status of a Voice
Paortal component, and generate reports related to system operation.

Legal Notice

® 2005 - 2010 Awaya Inc. All Rights Reserved. 5
Notice

While reasonable sfforts were made to ensure that the information in
this document was complete and accurate at the time of printing,

Avaya Inc. can assume no liability for any errors. Changes and
corrections to the information in this document might be

incorporated in future releases.

Documentation disclaimer

Avaya Inc. i= not responsible for any modifications, additions, or
deletions to the original published version of thi= documentation
unless such modifications, additions, or deletions were performed by
Avaya. Customer and/or End User agree to indemnify and hold harmless
Avaya, Avaya's agents, servants and employees against all claims, o5

Last Login: 7/23/10 1:57:54 FM EDT
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Figure 4: VPMS Main Screen
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4.1. Configure the H.323 VolP Connection

To configure an H.323 connection, navigate to the VoIP Connections page and then click on the
H.323 tab. Click on the Add button. In the Add H.323 Connection page, set the Gatekeeper
Address to the IP address of the C-LAN in the G650 media gateway and the Gatekeeper Port
to 1719. Next, configure the stations for Voice Portal, which map to the 7434ND stations
configured in Communication Manager. In addition, set the Password for the stations and set
the Station Type to Inbound and Outbound. Click the Add button when done. In this
configuration, stations 23801 to 23808 are assigned to Voice Portal. However, only stations
23802 and 23803 are mapped to the Nuance OSA application on Voice Portal in

Figure 10. Click Save.

AVAyA Welcome, admin

Last logged in today at 1:57:54 PM EDT

Voice Portal 5.1 (VoicePortal)

L e e ki Home VolP Connections
* User Management
Roles Add H.323 Connection
Usears
Login Options
* Real-Time Monitoring
System Monitor

Use this page to add a new H.323 connection.

Artive Calle e
Port Distribution Name: |devconis =~ = |
* System Maintenance
Audit Log Viewer Enable: @ Yes O Mo
Trace Viewer r
Log Viewer Gatekeeper Address: |10.32.24.20
Alarm Manzger . T
* System Management Alternative Gatekeeper Address: |
MPP Manager
Software Upgrade Gatekeeper Port:
Systemn Backup . .
¥ System Configuration Media Encryption:

Alarm Codes
Alarm/Log Options

Applications Mew Stations
MPP Servars
Report Data
SNMP Ta
Speech Servers |
VolIP Connections 23808
e 0 T [l |
* Security
Certificates
Licensing
* Reports (®) same Password
Standard
Custom O use sequential passwords
Scheduled
Inbound and Qutbound
Station Type: || Inbound Onhy
Maintenance
Configured Stations (M for Maintenance, I for Inbound Only)
[«Na Station>
[Save. [Help |
Figure 5: H.323 Connection
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4.2.

Add an MPP Server

Add the MPP server by navigating to the MPP Servers screen and selecting the option from the
left pane. In the MPP Server configuration page, specify a descriptive Name and the Host

Address of the MPP server. Also, specify the Maximum Simultaneous Calls supported by the
MPP server. The previously configured MPP server is shown below.

AVAYA

Voice Portal 5.1 (VoicePortal)

Expand All | Collapse all

* User Management
Raoles
Usars
Login Options

* Real-Time Monitoring
System Monitor
Active Calls
Part Distribution

* System Maintenance
Audit Log Viewsr
Trace Viewsr
Log Viewer
Alarm Manager

* System Management
MPP Manager
Software Upgrade
Systemn Backup

* System Configuration
Alarm Codes
Alarm/Log Options
Applications
MPP Servers
Feport Data
SNMP
Speech Servers
VoIP Connections
VPMS Servers

* Security
Certificates
Licensing

* Reports
Standard
Custom
Schaduled

Last logged in today at 1:57:54 PM EDT

Home MEP Servers

Change MPP Server

Use this page to change the configuration of an MPF. Take care when changing the MPF Trace Logging
Thresholds. Do not set Trace Levels to Finest if your Voice Portal system has heavy call traffic. The
systermn might experience performance issues if Trace Levels are set to Finest. Set Trace Levels to

Finest only when you are troubleshooting the system.

Name: MPP

Host Address: (10.32.2431 |
Network Address (WVoIF): =Default=

Network Address (MRCP): <Default> |
Network Address (AppSvr): =Default>

Maximum Simultaneous Calls: |20

Restart Automatically:

MPP Certificate

Cwner: CH=mpp, C=Rvaysz, OU=MEE
Issuer: CH=mpp, 0=Rvays, JU=MEF
Serial MNumber: Ba71206004103538

Valid from: July 1%, 2010 10:55:15 2M EDT until: July 16, 2020 10:55:15 aM EDT

Certificate fingerprints

MDS: a7:c5:14:Tc:de:84:5fc:4c:64:46:c4:2b:d0:592:
£:-1 7

SHA: bt:46:4f:8b:dl:aZ:£2:68:af:bo:bB:5E:

Categories and Trace Levels »

[ove J roon | conces e

=1 i

Welcome, admin

ff Home T~ Help 0 Logoff

d:Ze
d:72:bb:£fB:2fzea
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43.

Figure 7. Click Save.

Configure the VolP Audio Format

The VoIP Audio Format for the MPP server is configured in the VoIP Settings screen
accessible by selecting MPP Servers in the left pane. Click on the VoIP Settings button. In the
VoIP Settings screen, set the MPP Native Format field to audio/basic for mu-law as shown in

AVAYA

Voice Portal 5.1 (VoicePortal)

Expand All | Collapse All

* User Management
Roles
Usears
Login Options
Real-Time Monitoring
System Monitor
Active Calls
Port Distribution
* System Maintenance
Audit Log Viewer
Trace Viewer
Log Viewer
Alarm Manager
* System Management
MPP Manager
Software Upgrade
System Backup
System Configuration
Alarm Codes
AlarmifLog Options
Applications
MPP Sarvers
Report Data
SHMP
Speech Servers
VoIP Connections
VPMS Servers

1

1

Home MPP Servers

VolIP Settings

Woice over Internet Protocol (WolP) is the process of sending voice data through a network
using one or more standard protocols such as H.323 and Real-time Transfer Frotocol (RTF).
Use this page to configure parameters that affect how voice data is transferred through the
network. Note that if you make any changes to this page, you must restart all MFFs.

Port Ranges

Low |___High |

UDP: 23000 30999
TCP: 31000 31999
MRCP: 32000 32999
gi:ﬁgn: 35000 50000

RTCP Monitor Settings
Host Address:

Port:

Welcome, admin
Last logged in today at 1:57:54 PM EDT

9 of 32

* Security
Certificates VoIP Audio Formats
Licensing
~ Reports MPP Native Format: | audio/basic A
Standard
g;::od:ied Audio Codecs
Packet Time: 20 »
G729 ® ves O No
rReduced Complexity Encoder: (&) ves () No
Discontinuous Transmission: ® ves O No
First Offered: G729 +
QoS Parameters
| vLAN | Diffserv |
H.323: 6 46
SIF: 6 46
RTSP: 5 46
Out of Service Threshold (% of VoIP Resources)
| Reset |
Warn: 10 0
Error: 20 10
Fatal: 70 50
| save |If Apply [ Help |
Figure 7: VolP Settings
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44,

Add an ASR Server

To configure the ASR (automatic speech recognition) server, click on Speech Servers in the left
pane, select the ASR tab, and then click Add. For a Nuance Speech Server, the Engine Type
should be set to Nuance. Set the Network Address field to the IP address of the Nuance Speech
Server and select the desired Languages supported by the application. The Total Number of
Licensed ASR Resources should also be set to the appropriate value. Set the Protocol field to
MRCP V2. The other fields were left at their default values. Click Save.

AVAYA

Voice Portal 5.1 (VoicePortal)

Expand &ll | Collapse All

* User Management
Roles
Users
Lagin Options

* Real-Time Monitoring
System Monitor
Active Calls
Port Distribution

* System Maintenance
Audit Log Viewer
Trace Viewer
Log Viewer
Alarm Manager

* System Management
MPP Manager
Software Upgrade
Systemn Backup

* System Configuration
Alarm Codes
Alarm/Log Options
Applications
MPP Servers
Report Data
SNMP
Speech Servers
VoIP Connections
VPMS Servers

* Security
Certificates
Licensing

* Reports
Standard
Custom
Scheduled

Hoeme

Add ASR Server

Use this page to configure Voice Portal to communicate with a new ASR server.

Name:

Enable:

Engine Type:

Network Address:

Base Port:

Total Number of Licensed ASR Resources:

New Connection per Session:

Languages:

MRCP

Ping Interval: 15 ...... second(s)
Response Timeout: |4 zecond(s)
Protocol: MRCP W2 V

[ Sove [ cancel J el

Welcome, admin
Last logged in today at 1:57:54 PM EDT

Speech Servers

MNuance ASR

@ Yes O No

Muance

Dutchi(Metherlands) nl-ML
English(Australia} en-Al
English(UK) en-GB = |
English{India) en-IN |
English{Singapore) en-SG
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Figure 8: ASR Speech Server
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4.5. Add aTTS Server

To configure the TTS (text to speech) server, click on Speech Servers in the left pane, select the
TTS tab, and then click Add. For a Nuance Speech Server, the Engine Type should be set to
Nuance. Set the Network Address field to the IP address of the Nuance Speech Server and
select the desired Voices supported by the application. The Total Number of Licensed TTS
Resources should also be set to the appropriate value. Set the Protocol field to MRCP V2. The

other fields were left at their default values. Click Save.
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Voice Portal 5.1 (VoicePortal)

Expand All | Collapse All

* User Management
Roles
Users
Login Cptions

+* Real-Time Monitoring
System Monitor
Active Calls
Port Distribution

* System Maintenance
Audit Log Viewer
Trace Viewer
Log Viewsr
Alarm Manager

* System Management
MPP Manager
Software Upgrade
Systemn Backup

* System Configuration
Alarm Codes
Alarm/Log Options
Applications
MPP Servers
Report Data
SNMP
Speech Servers
VoIP Connections
VPMS Servers

* Security
Certificates
Licensing

* Reports
Standard
Custom
Scheduled

Home
Add TTS Server

Use this page to configure Voice Portal to

Name:

Enable:

Engine Type:

MNetwork Address:

Base Port:

Total Number of Licensed TTS Resources:

Mew Connection per Session:

Voices:

MRCP

Ping Interval: 15 ...... second(s)
Response Timeout: |4 second(s)
Protocol: MRCP W2 V

| save | cancel [ velp |

Welcome, admin
Last logged in today at 1:57:54 PM EDT

Speach Servers

communicate with a new TTS server.

Muance TTS

@'YES O Mo

Muance  +

English(USA) en-US Jill F A
English(USA) en-US Lisa F

English(USA) en-US Samantha F

English(USA) en-US Tom M
English(USA) en-US Vicky F
Finnish(Finland) fi-Fl Mikko F e
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Figure 9: TTS Server
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4.6. Add an Application

On the Applications page, add a Voice Portal application. Specify a Name for the application,
set the Type field to VoiceXML, and set the VoiceXML URL field to point to the Nuance OSA
application. Next, specify the type of ASR and TTS servers to be used by the application and the
called numbers that invoke the Nuance OSA application. The called number 23802 is used to
access the “top-level menu” entry point and the called number 23803 is used to access the “DNIS
Test” entry point. The Applications screen is shown in

Figure 10. Click Save.

AVAYA

Voice Portal 5.1 (VoicePortal)

Expand &ll | Collapse All

* User Management
Roles
Usears
Login Options

T Real-Time Monitoring
System Monitor
Active Calls
Port Distribution

* System Maintenance
Audit Log Viewer
Trace Viewer
Log Viewer
Alarm Manager

* System Management
MPP Manager
Software Upgrade
Systemn Backup

- System Configuration
Alarm Codes
Alarm/Log Options
Applications
MPP Servers
Report Data
SNMP
Speech Servers
VoIP Connections
VPMS Servers

* Security
Certificates
Licensing

* Reports
Standard
Custom
Scheduled

Welcome, admin
Last logged in today at 11:20:57 AM EDT

Type: | VaiceXML v

URL
® Single ) Fail over ' Load Balance

VoiceXML URL: ;http:.r".."lU.32.2=t-.].4lfOpenSpeech.-"Attendantfservlet"'aa

Mutual Certificate Authentication: O Yes @ Mo

O Yes @ No

Basic Authentication:

Speech Servers

| Nuance TTS: | Nuance »

ASR:
[ Eng English{USA) en-US Samantha F |
Languages: | | Voices:

Application Launch

@ 1nbound O Inbound Default O Outbound

® Number O Number Range O UuRI

Called Number: |

é_zaana

Speech Parameters »
Reporting Parameters »

Advanced Parameters »

[ sove ] concel il |
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Figure 10: Applications
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4.7. Start the MPP Server

Start the MPP server from the MPP Manager page shown in
Figure 11. Select the MPP and then click the Start button. After the MPP is started, the Mode
of the MPP should be Online, the State should be Running, and Config should be OK.

AVAYA

Voice Portal 5.1 (VoicePortal)

* User Management
Roles
Users
Login Options

L]

System Monitor
Active Calls
Port Distribution

Audit Log Viewer
Trace Viewar
Log Viewer
Alarm Manager

MPP Manager
Software Upgrade
System Backup

Alarm Codes
Alarm/Log Options
Applications
MPP Servers
Report Data
SHNMP
Speech Servers
VolIP Connections
VPMS Servers
* Security
Certificates
Licensing
Reports
Standard
Custom
Scheduled

4

Expand All | Collapse All

Real-Time Monitoring

¥ System Maintenance

* System Management

* System Configuration

Welcome, admin
Last logged in today at 1:57:54 FM EDT

are here: Home * System Management > MPP Manage

MPP Manager (7/23/10 3:13:21 PM EDT) REESh

Thi=s page displays the current state of each MPF in the Voice Portal system. To enable the state and mode

commands, select one or more MPPs. To enable the mode commands, the selected MPPs must also be stopped.

Last Poll: 7/23/10 3:13:17 PM EDT

Restart Schedule | Active Calls
Server Name Auto Restart .
Today Recurring In Cut
0

[¥] mpP Cnline Stopped  MNone No & No & Mone & 0

State Commands

Restart/Reboot Options
O One server at a time

(&) All selected servers at the same time

JAO; Reviewed:
SPOC 8/24/2010

Figure 11: MPP Manager
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5. Configure Nuance OpenSpeech Attendant

This section covers the procedure for configuring Nuance OpenSpeech Attendant (OSA). The
procedure includes the following areas:

e Administer settings in the Configuration Panel

e Administer transfer entries in the Phone Directory and Menu Editor
¢ Administer top-level menu in the Phone Directory and Menu Editor
e Administer caller utterance recording

Note: The Vocalizer config file, ttsrshclient.xml, located in C: \Program
Files\Nuance\Nuance Vocalizer for Network 5.0\config directory of the speech
server must be tuned to interoperate successfully with Nuance OSA. The tag

<ssml validation> must be setto none. The default value is strict.

Nuance OSA is configured through Admin Tools which can be started by navigating to

Start->Nuance-> Admin Tools. The initial screen is displayed as shown in
Figure 12.

i®l Admin Tools [_ O]

OMSpeechD

ATTENDANT

Start

Stop

kd anitar

Directary Search

Prampt Recorder

Phone Directon and Menu Editor

FRepart Generataor

Backup / Restare

[rata import

Help

Figure 12: Admin Tools
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5.1. Administer Settings in the Configuration Panel

To open the Configuration Panel, click on this option in the Admin Tools window in
Figure 12. The login prompt will be displayed to the user as shown in
Figure 13. Log in with the appropriate credentials using Level 2 access level.

Configuration password I

Accesz level
I Lewvel 2 i I

Pazsword

Ixxxxxa1

(1] I Cancel

Figure 13: Configuration Panel Login Window

The Configuration Panel shown in

Figure 14 is displayed. The Configuration Panel allows the transfer mode and operator
extension number to be configured. Nuance OSA supports blind, supervised, and bridged
transfers with Voice Portal. To enable OSA for blind transfers, set the Gateway Transfer Mode
Supervised and Gateway Transfer Mode Bridged fields to NO as shown in the figure below.
For supervised and bridged transfers set the corresponding fields to YES. The Operator
Extension Number field should be set to a valid extension on Communication Manager. Click

Apply.

@l Configuration panel - level 2

Eile Tools Help

Setting | | Current value | Default ;l Gateway Transfer Mode Bridged
Server Trace Level DEY DEY
Dump session logs enabled ALWEYS ALWEYS IND LI
destination $LOCUS_DATAE  $LOCUS_DATAS
shyle PROGRESSIVE PROGRESSIVE
Dump session stats enabled oM oM
destination JLOCUS_DATAS  SLOCUS_DATAS
rumber of daps to keep in database 20 20
CLID exclusion list
Mumber of Ports 1 1
Authorized nurbers for DTMF pass through INTERMAL ONLY  INTERMAL ONLY
@ Default Transfer Options =+ UMSUPERWISED SUPERYISED
@ Gateway Transfer Mode Bridged MO MO
Action on miszing phone number AMMOUNMCE AM...  AMMOUMCE AMD OFFE
Action an invalid phone number TRAMSFER TRAMSFER
Gateway Transfer Connection Timeout i} i}
Gateway Transfer Maximum Call Duration 36000 36000
Gateway Transfer Options Sting
Gateway Tiansfer Pause Character p p
Gateway Transfer URI type TEL TEL
Gateway Transfer SIP URI suffis localhost 5060 localhost 5060
Call &nalyzer recorded channels MOME MOME
System Languages en-LIS en-LIS
@ Operator Extension Mumber o FFa03 o
Action on transfer to operatar off duty AMMOUNCE AM... AMMOUNCE AMD TRAM
Operator access befare first name seach oM oM
TOD Operator Extension Mumber u] u]
Speed-Dial Key 1 o o

Speed-Dial Key 2 9 9
Snead-Misl K an 3 =qq =g h Restare |
>
License | Apply I

4]
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Figure 14: Configuration Panel
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Note: To support supervised transfers, the special application SA8874 — Call Status Messages
for 7434ND IP Softphone must be enabled on Communication Manager. When using supervised

transfers, the caller won’t hear any ringing during the transfer attempt.

Next, close the Configuration Panel. Activate the changes when prompted by the system as

shown
Figure 15.

Warning! |

L] ¥ou have made changes that require a swskem reskart,
[} Do ol wank to do ik now?

Figure 15: Activate Changes in Configuration Panel
The following window is displayed. Click OK.

Starting Openspeech Attendant

Cpenspeech Atkendant skartup in progress

Figure 16: Startup in Progress Window
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5.2. Administer Transfer Entries in Phone Directory and Menu Editor

From Admin Tools, click on the Phone Directory and Menu Editor option.
Figure 17 is displayed.

&l Menu Editor =] 3
File Edit Yiew Tools Help
N R R A
Menuz Content of "Toplevel Menub'
G 120 ) O 2 ) S ) a0 e [ R N S B
4
| ¥l Mame | Department | Location | SR | Numberl Fhone t_l,lpel DTHF |Access to hame re... | DTHF menu index |
: Cellular Phones x>
: Croft, Lara w Franz Office "
: Fent, Clark s 7303 Office ks
1 entries selected [
Fhone Directary | D ata import |
Figure 17: Phone Directory and Menu Editor
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Next, select File>New=> Transfer Entry from the menu options. The Creating transfer entry
window is displayed as shown in

Figure 18. Configure the First names and Last names for this entry and set the Number to a
valid extension. Enable the Access to personal functions and Access to name recorder options
and set the PIN field so that this user can access the Personal Administration Mode (PAM) to
change their name recording. Click OK.

¥} Creating transfer entry [ x|

Mame in directany I [~ Deactivated entry [~ DTMF Menu Indes I

Mames |Advanced| Call Accountingl Infnrmationl £ chedule I.&Iwa_l,ls j
Firzt names Middle hames Last names Always |
Dravid Wells n
— — — [v Speech recognition
Mumber type Hurmber S U FM# Prv
¥ |Office = ||77301 rerer .
- [ o = ] o e
Aliazes [English [US]]
Allow:
[¥ &cocess o personal functions PIM I’""‘“
[ “oice biometrics
[V Access to name recorder Password I
Message INgne | New
[~ Mewver propose this name Custam Prompt
|
Create Perzonal Direston | [elete Personal Directon |
Frexvious Hew | [t | (0] Cancel Apply

Figure 18: Creating Transfer Entry
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The new transfer entry is now displayed in the Menu Editor window, but the entry has not been
activated yet. Highlight the new transfer entry and then click on the Activate Changes icon

[=],

&l Menu Editor

= e
File Edit Yiew Tools Help
$ BB B G e, Tk,

Menus
[-{E] Toplevel Menu
e 120 ) O 2 S ) G e [ R S B |
| ¥l Mame | Department | Location | SR | Numberl Fhone t_l,lpel DTHF |Access to hame re... | DTHF menu index |
E Cellular Phones >
c Croft, Lara w Franz Office "
E ¥ 77M03  Office %

7730 Office

1 entries selected [

Fhone Directary | D ata import |

Figure 19: Menu Editor with New Transfer Entry

The following prompt is displayed to activate the new transfer entry so that it would be
recognized by Nuance OSA.

Change Activation

&n activation af the changes has been requested.

Figure 20: Change Activation
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5.3. Administer Top-Level Menu in Phone Directory and Menu Editor

Nuance OSA allows the configuration of multiple entry points. The use of multiple entry points
enable individual services or departments to be assigned a different entry point, which can be
configured using a DNIS or CLID number. When a call is received, Nuance OSA can route the
call to the appropriate entry point based on the dialed number (DNIS) or the caller’s phone
number (CLID). In this example, an entry point was configured using the DNIS option.

Create a new entry point by selecting File->New—>Top-Level Menu from the menu options.
The window in

Figure 21 is displayed. Enter a descriptive name in the Aliases field, enable the Access to name
recorder option, and set the PIN field for use with PAM. Click OK to activate the changes.

Mamg in directany I [~ DTHF Menu Index I—
Hames |Advanced| Cal A-:cc-untingl Inf-:-rmatic-nl Meru B ehavior |Security .-’-\-:ces&l
Scheduls IAIwa_l,ls j
First names Middle names Last names

Access code I
[V Call redirect permitted

Ciefault rumber

I.-’-‘m_l,l type j
Conwersation template
IDefauIt j_l
Aliazes [English [US]] Always |
DMIS Test Newtstep  [Operator =]
Action triggerl Mone j

Settings |Gleeting| F'romptl Albernative F'mmptl Help 4 I ’I

[¥ Speech recognition

Allow: IMenu behavior 1 j Mew |
I™ iccess to personal functions S I MHurnber of utterances DOperator extension

[~ Voice biometrics

Crefault -
¥ Acocess o name recorder Passwmard I I J I

Mumber of spelings Woice profile

[~ Never propose this name IDefauIt j IDefauIt fram entry pon
MHurnber of interactions Barge-in function
IDefauIt j IDefauIt fram entmy poj

[ Always ask for confirmation

[~ Listing of entries

Frevious [ [t | Ok Cancel Apply

Figure 21: Creating Menu
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From the Menu Editor, navigate to Edit->Ports and Entry Points to display the window in
Figure 22. Select the first item under Port assignment in the left pane and then select
Add->Entry Point from the menu options.